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Procedure

This topic will teach you how to create a T.A. (TAR).

rlu tome | Workist | AddtoFavories | Sianout

Personalizs

ent | Layout Help

Menu = B
Search:
®
[~ My Favorites
[- Student Administration
[ Employee Self-Service
> Manager Self-Service
[+ Supplier Contracts
[- Customers
[- Products
[ Promotions
[> Customer Contracts
[- Order Management
[- Pricing Configuration
[ Customer Retumns
[ ltems
[ Cost Accounting
[- Vendors
> Purchasing
[+ Inventory
[+ eProcurement
[- Services Procurement
- Sourcing
[ Engineering
[> Manufacturing Definitions
[ Production Control
[ Configuration Modeler
I Product Configurations
[- Quality
> Demand Planning
[+ Inventory Policy Planning
[+ Supply Planning
[- Grants
> Program Management
[ Project Costing
> Proposal Management
> Maintenance Management
- Resource Management
[ Lease Administration
[- Staffing
[ Travel and Expenses
[+ Travel Administration

[+ Billing
[ Accol ﬂ
Done [ [ [ @ nternet HI00% -

Step | Action

1. Click the Employee Self-Service link.

[- Employee Self-Service|

2. Click the Travel and Expense Center link.

[Travel and Expense Cented
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FIU

I~ Employee Self-Service
> Service Request

I Procurement Travel and Expense Center

[ Assets

I Travel and Expenses Employee Travel and Expense Center

— Open Resource Requests Expense Report Time Report ravel Authorization

Emopl e Project Center ‘ Create, modify, print, view or delete an @ Create, modify, print, view and delete a Time reate, modify, print, cancel or delete a
X Report Report Authorization
[ Manager Self-Service B g te B €
(- Supplier Contracts Eﬁ* Eﬁ* Eﬁ!
P E BT Zlire Zore e
[ Products — — —
- Promotions Cash Advance Forecast Time “i Print Reports
[ Customer Contracts @ reate, modify, print, view =ate, modify or view forecast data Qﬂprimanycns of your expenss transactions.
(- Order Management A ce. ime ElExpense Report
b [PCE L (Ea g eiErm Bcreate sview Forscasted Time B18ar Cose Receipt Form
(> Customer Returns = odify B Time Report
[ Items B print 2 More.
- Cost Accounting 2 More....
E\;im;:‘m Profiles and Preferences Review Payments Other Expense Functions
b e anage your personal, organizational and Wiew contents in My Wallet, create your owin
b financial details for travel and expense template, or modiy and existing template.
reporting. B Create/Update User Template

(- Services Procurement Frevie B iy Wallet
[ Sourcing bil
> Engineering T EDelecate Entry Authority
> Manufacturing Definitions
(- Production Control Travel Services
> Configuration Modeler rvations, Change your
[ Product Configurations rds, and log on to Travel Partner sites
[ Quality

(> Demand Planning

[ Inventory Policy Planning
(- Supply Planning

[ Grants

[ Program Management

[ Project Costing

> Proposal Management

[+ Maintenance Management
> Resource Management

[- Lease Administration

[+ Staffing

(- Travel and Expenses

[ Travel Administration

> Billing -

pene N

[ Iravel Partner Logon

100% -

Step | Action

3. Click the Travel Authorization link.

4, Click the Create link.
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FIU

Search:
(- My Favorites - .
> Student Administration Create Travel Autherization

e R | | sianout

New Window | Hslp | Customize Pace | 5 =]

- Employee Self-Service

SR Travel Authorization Entry

[ Procurement Patty Panthar
[> Assets
[> Travel and Expenses Quick Start:

— Open Resource Reguesis
— Emplovee Project Center =

User Defaults

A Blank Authorization x| GO

Authorization 1D: NEXT

(- Order Management

— Travel and Expense Center . ) . o
> Manager Self-Service Description: I Comment: J
(> Supplier Contracts *Business Purpose: | ﬂ ﬂ
[- Customers
> Products Default Location: | aQ
[ Promotions . . N |
> Customer Contracts Date From: [ [ *Date Tox &

(> Pricing Configuration

Acc q
VP EnTe o ccounting Defaults

More Options:

[- ltems
[+ Cost Accounting

[- Vendors

Select “Expense Type

~Amount Currency | “Payment Type

> Purchasing
[ Inventory

[- eProcurement
[- Services Procurement

(> Engineering

(- Manufacturing Definitions
[ Production Control

(- Configuration Modeler

[ Product Configurations

> Quality

> Demand Planning

[+ Inventory Policy Planning

I
I
> Sourcing I
I

Copy Selected | Delete Selected |

Authorized Amount:

MNew Expense ~| Add Check For Errors

0.00 USD

[+ Supply Planning
[- Grants |

Update Totals | |

> Program it

(- Project Costing

> Proposal Management

[ Maintenance Management
(- Resource Management

Il nmra Ardminictratinn

Save for Later Submit

Return to Travel Authorization

Create A Cash Advance Praject Summary Printable View

Done

=l
N 4

00 -

/@ tnternet

Step | Action

MBA Seminar".

Enter the desired information into the Description field. Enter

"Coll. of Bus
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Search:

(O]

- My Favorites
[ Student Administration
- Employee Self-Service
> Service Request
[> Procurement
[> Assets
[» Travel and Expenses
— Open Resource Reguesis
— Employee Project Center
— Travel and Expense Center
> Manager Self-Service
[+ Supplier Contracts
[- Customers
[- Products
[ Promotions
[ Customer Contracts
(- Order Management
(> Pricing Configuration
[ Customer Returns
[- ltems
[+ Cost Accounting
[- Vendors
> Purchasing
[ Inventory
[- eProcurement
[- Services Procurement
> Sourcing
(> Engineering
(- Manufacturing Definitions
[ Production Control
(- Configuration Modeler
[ Product Configurations
> Quality
> Demand Planning
[+ Inventory Policy Planning
[+ Supply Planning
[- Grants

Create Travel Autherization

New Window | Hslp | Customize Pace | 5 =]

Travel Authorization Entry

Patty Panther User Defaults Authorization 1D: NEXT

Quick Start: A Blank Authorization x| GO

=
*Description: |Cm| of Bus MBA Seminar Comment: j
*Business Purpose: | ﬂ

Default Location: |

= o Ll

*Date From: [ [ *Date To:

More Options: |

| A inting Defaults

Select “Expense Type ~Amount Currency

L L el f Lo

Copy Selected | Delete Selected |

MNew Expense ~| Add

Authorized Amount: 0.00 USD

Check For Errors

Update Totals | |

> Program it

(- Project Costing

> Proposal Management

[ Maintenance Management
(- Resource Management

Il nmra Ardminictratinn

=

Save for Later Submit Create A Cash Advance Project

Summary Printable View

Return to Travel Authorization

Done

N

=
4

00 -

/@ tnternet

Step | Action

Click the Seminar list item.

=1
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rlu Home | Workist | _AddtoFavories | Sinout

Search: = New Window | Hslp | Customize Pace | 5 =]

- My Favorites

[ Student Administration
V;’“ﬁz‘fﬁgég-ﬁ;‘”“ Travel Authorization Entry
[> Procurement Patty Panther User Defaults Authorization 1D: NEXT
[> Assets
[> Travel and Expenses Quick Start:
— Open Resource Reguesis
— Employee Project Center

— Travel and Expense Center - . ol 1BA o, ) -
[ Manager Self-Service Description: |C:\I of Bus MBA Seminar Comment: =

> Supplier Contracts *Business Purpose: - El
[- Customers
> Products Default Location: | aQ
[ Promotions

> Customer Contracts “Date From: [ i) “Date To: | &
(- Order Management
(> Pricing Configuration
[ Customer Returns

[- ltems

[> Cost Accounting el Customize | First 4] 14 ora [H Last
[- Vendors *7
> Purchasing

Create Travel Autherization

A Blank Authorization hd B

-

| Accounting Defaults More Options: | j GO |

Select “Expense Type “Date “Amount Currency |“Payment Type | Billing Type

[ Inventory
[- eProcurement

I
[~ Services Procurement |
I

> Sourcing

(> Engineering
(- Manufacturing Definitions I
[ Production Control

igfg‘jﬁ;’g‘éﬂ:ﬁgiﬁﬁ Copy Selected | Delete Selected | [New Expense =] A _Check For Erors |
> Quality

> Demand Planning

[ Inventory Policy Planning Authorized Amount: 0.00 USD
[+ Supply Planning

[- Grants |
> Program it
- Project Costing Save for Later Submit Create A Cash Advance Project Summary Printable View
> Proposal Management
[ Maintenance Management Return to Travel Authorization

(- Resource Management j j
i 1 narn Adminictrating

Done [ T e ntenet e -

L L el f Lo

Update Totals | |

Step | Action

7. Enter the desired information into the Default Location field. Enter "CA".

8. Click the Look up Default Location (Alt+5) button.

[

9. Click an entry in the Expense Location column.

10. | Enter the desired information into the Choose a date (Alt+5) field. Enter
"7/1/09".

11. Enter the desired information into the Date To field. Enter "7/5/09".

12. | Click the Accounting Defaults link.
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Search: =l Mew Window | Help | Customize Page | 15

rlu tHome | Workist | _AddtoFavories | Sinout

(O]

[ My Favorites Create Travel Authorization

[ Student Administration
[~ Employee Self-Service Accounting Defaults
> Service Request
[ Procurement Parthy Panther
[> Assets
[» Travel and Expenses
— Open Resource Reguesis
— Employee Project Center % *GL Unit Dept
— Travel and Expense Center

[+ Supplier Contracts

s Add ChantField Line | | Load Defauts |
[- Products

[ Promotions

[ Customer Contracts oK

(- Order Management
[+ Pricing Configuration GoTo: User Defaults
[ Customer Returns
[- ltems

[+ Cost Accounting
[- Vendors

> Purchasing

[+ Inventory

[- eProcurement

[- Services Procurement

> Sourcing

(> Engineering

(- Manufacturing Definitions
[» Production Control

(- Configuration Modeler

[ Product Configurations

> Quality

> Demand Planning

[+ Inventory Policy Planning
[+ Supply Planning

[- Grants

> Program Management

(- Project Costing

> Proposal Management

[ Maintenance Management
(- Resource Management

b nmra Adminictratinn

|4l

Authorization 1D:

Class Fund  Program Bud Ref

> Manager Self-Service 700,00 [Fuo1 | @ [238000818 @ [T @ 335/ @ [78 @ aQ |

PC Bus
Unit

NEXT

Project

Set Personalizations | Find | #

Activity

ol

Affiliate

First [

Fund A

al al |

i

Done

T

| tnternet

|, 100%

T A

Step | Action

13.

Enter the desired information into the % field. Enter "50.".

In the Accounting Defaults, you can split the percentage between several
Project IDs (FUNDWARE ACCOUNTS).

Run the following query to identify the correct combination of the above fields
for a particular project ID: FIU_DEPT_PROJ_LOOKUP

14.

Click the GL Unit button.

15.

Click an entry in the Business Unit column.
FILIDZ

16.

Enter the desired information into the begins with field. Enter "231001000".

17.

Click the Look Up button.

Look Up

18.

Click an entry in the Department column.

19.

Enter the desired information into the begins with field. Enter "900".

20.

Click the Look Up button.
Look Up

Last changed on: 10/2/2009 8:07 AM Page 7
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Step | Action

21. | Click an entry in the Fund Code column.

22. | Click the Program button.

[

23. | This field will always be "00" Misc. for all Direct Support Organizations (DSO)

Click an entry in the Program Code column.

24, Click the PC Bus Unit button.

25. | Click an entry in the Business Unit column.
FIL02

26. | Click the Project button.

[

27. | Enter the desired information into the begins with field. Enter "1200010".

28. | Click the Look Up button.

29. | Click an entry in the Project column.

30. | Click the Activity button.
[&]

31. | Click an entry in the Activity column.
EVEMNT1

32. | Click the Add ChartField Line button.
| Add ChartField Line |

33. Enter the desired information into the % field. Enter "5".

34. Click the GL Unit button.

35. | Click an entry in the Business Unit column.

36. | You can type Or search for the Dept. number

37. Enter the desired information into the Fund field. Enter "900".

38. | Enter the desired information into the Program field. Enter "00".

39. Enter the desired information into the PC Bus Unit field. Enter "FIU02".

40. | Click the Project button.

41. | Enter the desired information into the begins with field. Enter "1200130".
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Action

Click the Look Up button.
Look Up

1200130

Click an entry in the Project column.

Click the Activity button.

Not every project ID is associated with an activity.

45.

EVENTA

Click an entry in the Activity column.

46. Click the OK button.

oK

ok |
FIU
C—

Search:

(- My Favorites

' Student Administration Create Travel Autherization

Home | orkist | AddtoFavortes | Sianout

[ =
e

Mew Window | Help | Customize Page

[~ Employee Self-Service

[» Service Request

[> Procurement

[ Assets

[ Travel and Expenses

— Open Resource Requests
— Employee Project Center

Travel Authorization Entry
Patty Panthar
Quick Start: A Blank Autharization

-

User Defaults

Authorization ID: NEXT

GO

— Travel and Expense Center

- Manager Self-Service “Description:

|cm| of Bus MBA Seminar

Comment:

(> Supplier Contracts

|Semmar
[ Customers

*Business Purpose:

H

[ Products
[ Promotions

Default Location: |Ca\if-:rma Bakersfield

a

[ Customer Contracts *Date From: |U?¢U1JZUUEI *Date To:

- Order Management

07/05/2009

[+ Pricing Configuration

Acee
b B T ceounting Defaults

More Options: |

[- ltems
[+ Cost Accounting

[- Vendors

Select “Expense Type

tomize | Find

*Amount Currency |*Payment Type |"Billing Type

- Purchasing
> Inventory

[ eProcurement

(- Sourcing

(- Services Procurement |
(- Engineering I

(- Manufacturing Definitions I
[+ Production Control

(> Configuration Modeler
> Product Configurations Eoniseedeg |
[ Quality

> Demand Planning

[ Inventory Policy Planning

Delete Selected |

Authorized Amount:

B|H{E ®

New Expense ~| Add Check For Errors

0.00 UsD

> Supply Planning
[- Grants |

Update Totals |

[ Program it

(- Project Costing

(- Proposal Management

[ Maintenance Management
[~ Resource Management

[P

2ave for Later Submit

Return to Travel Authorization

=l

Create A Cash Advance Project Summary Erintable View

I
4

I -

E100% -

Step | Action

47. | Click the Expense Type list.

=)

Last changed on: 10/2/2009 8:07 AM
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are
Domestic Auto Rental
Domestic Incidentals

- Domestic Meal-Entertainmen 7 E]
Search: = Domestc Meals New Window | Help | Customize Page | ni,
@ Domestic Mileage
- My Favorites Domestic Registration
" Student Administration Create 1 Domesic TaiTranEus
- Employee Self-Service oreign Airfare
[> Service Request Trave Foreign Aute Rental
I> Procurement Patty PanForeign Incidentals User Defaults Authorization 1D: NEXT
- Assets Foreign Lodging
[> Travel and Expenses £ Foreign Meal-Entertainment
— Open Resource Reguests . Fareign Meals T Tra— ] d
— Emplovee Project Center DescriForeign Mileage | eminar Comment:
— Travel and Expense Center ~gusindForeion Registration ﬁ =
> Manager Self-Service Foreign Taxi/Train/Bus )
[> Supplier Contracts Defaul-Books & Educational Suppli 5015 Q
[ Customers _Clothing and Unifarms
- Products “Date {_Fees and Senices |"Date To: |07/05/2009
(> Promotions _EDO::I 4 casal
[ Customer Contracts uels and Gasoline -
(> Order Management i aterials and Supplies More Options: | LI fets]
[> Pricing Configuration emberships and Fees
- Customer Returns _Office Supplies
PIES Select -Fostace |'bate  |-Amount  |Currency *Payment Type |"Billing Type
[ Cost Accounting — |==ed ,?eslrm;eﬁn St “Date ¥ |"Pay! ype |*Billing Type
[ Vendors _Team Airfare In State ! 200 |usD = e
[ Purchasing = Team Airfare Out State A I I J | “Detail
[ Inventory j
[- eProcurement
[- Services Procurement | d
> Sourcing
(> Engineering I ﬂ|
[ Manufacturing Definitions
L Producﬁon{?gntro\ Copy Selected | Delete Selected | New Expense ~| Add Check For Errors
(- Configuration Modeler
[ Product Configurations
[ Quality Authorized Amount: 0.00 USD
> Demand Planning
[+ Inventory Policy Planning | Undate Totals |
[+ Supply Planning
P Save for Later Submit Create A Cash Project Summary Printable View
> Program it
- Project Costing Return to Travel Authorization

> Proposal Management
[ Maintenance Management
(- Resource Management j

b nmra Adminictratinn

Done [T @ ntenet

o0 -

Step | Action

48. Click the Domestic Airfare list item.

Page 10 Last changed on: 10/2/2009 8:07 AM
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Search:

&
- My Favorites
[ Student Administration
- Employee Self-Service
> Service Request
[> Procurement
[> Assets
[» Travel and Expenses
— Open Resource Reguesis
— Employee Project Center
— Travel and Expense Center

FIU

Create Travel Autherization

| Sian out

Mew Window | Help | Customize Page | 15

Travel Authorization Entry

> Manager Self-Service
[+ Supplier Contracts

[- Customers

[- Products

[ Promotions

[ Customer Contracts

(- Order Management

(> Pricing Configuration
[ Customer Returns

[- ltems

[+ Cost Accounting

[- Vendors

> Purchasing

[ Inventory

[- eProcurement

[- Services Procurement
> Sourcing

(> Engineering

(- Manufacturing Definitions
[ Production Control

(- Configuration Modeler
[ Product Configurations
> Quality

> Demand Planning

[+ Inventory Policy Planning
[+ Supply Planning

[- Grants

“Date

Patty Panther User Defaults Authorization 1D: NEXT
=)
=Description: [Call. of Bus MBA Seminar Comment: =]
Purpose: |Semmar =l =
Default Location: |Ca\iforma Bakersfield (s}

From: [07/01/2008 [ “Date To: [07/05/2009

| Accounting Defaults

More Options:

— “Expense Type "Date “Amount “Payment Type
[mI(Comesiic Airare =1 [ 0.00 [UsD =l
Copy Selected | Delete Selected | MNew Expense ~| Add Check For Errors
Authorized Amount: 0.00 USD

Update Totals |

Save for Later

Submit Create A Cash Advance Project Summary Erintable View

> Program
(- Project Costing

> Proposal Management

[ Maintenance Management
(- Resource Management

ol amen A

it

minietratinn

Return to

Travel Authorization

Done

L @me

0% -

Step

Action

49.

Enter the desired information into the Date field. Enter "7/1/09".

50.

Enter the desired information into the Amount field. Enter "420.".

Last changed on: 10/2/2009 8:07 AM
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rlu Home | Workist | _Addto Favories

Search: = New Window | Help | Customize Page | 15

(O]

| Sianout

(- My Favorites - .
> Student Administration Create Travel Autherization

[~ Employee Self-Service Travel Authorization Entry
> Service Request

[> Procurement Patty Panther User Defaults Authorization ID: NEXT
[> Assets
[» Travel and Expenses o
7Hmﬂ"u’:{:%“;§:§;ﬁ;‘5 “Description: |cm| of Bus MBA Seminar Comment: H
— Travel and Expense Center Purpose: Seminar - =
> Manager Self-Service P I J J
(- Supplier Contracts Default Location: |Ca\iforma Bakersfield Q
[> Customers
I Products *Date From: II]?/I]VZEII]EI *Date To: |07/05/2009
> Promotions
[ Customer Contracts
(- Order Management
(> Pricing Configuration
[ Customer Returns

| Accounting Defaults IMore Options:

[- ltems B B B

! pe ypi
> Cost Accounti Expense Type ite “Amount Payment Type
> Vendors ™ | [Domestic sirfare [70e || 420, [UsD -

> Purchasing

B
(> Inventory I ﬂ
E

[- eProcurement
[~ Services Procurement |
> Sourcing

(> Engineering I ﬂ
[ Manufacturing Definitions

s Producﬁonggntro\ Copy Selected | Delete Selected | New Expense | Add Check For Errors
(- Configuration Modeler
[ Product Configurations
[+ Quality Authorized Amount: 0.00 USD
> Demand Planning |

[+ Inventory Policy Planning
[+ Supply Planning
[- Grants

Update Totals |

Save for Later Submit Create A Cash Advance Project Summar, Printable View
> Program it
[ Project Costing Return to Travel Authorization
> Proposal Management
[ Maintenance Management
(- Resource Management j
i 1 narn Adminictrating 7
Dore [T T [@mterne i -

Step | Action

51. Click the Out of Pocket list item.
L -1

52. | Click the FIU Expense list item.
| I

53. Click the Domestic Auto Rental list item.
[ I
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FIU

Search:

(O]

- My Favorites

> Student Administration Create Travel Autherization

e R | | sianout

Mew Window | Help | Customize Page | 15

- Employee Self-Service
> Service Request
[> Procurement
[> Assets
[» Travel and Expenses o
— Open Resource Reguesis
— Employee Project Center
— Travel and Expense Center

> Manager Self-Service

[+ Supplier Contracts

[- Customers

[- Products

[ Promotions

Travel Authorization Entry

Patty Panther User Defaults

[Call. of Bus MBA Seminar

|Semmar

*Description:

[Califernia Bakersfield Q
[07/01/2008 [ “Date To: [07/05/2009

Purpose:

Default Location:

“Date From:

Authorization ID: NEXT

Comment:

[ Customer Contracts
(- Order Management

Accounting Defaults

More Options: |

(> Pricing Configuration
(> Customer Returns

[- eProcurement

[- ltems B B B B E
— |Select| Expense Type “Billing Type
© Cast Accounting Select| |"Expense Type Date ‘Amount Currency *Payment Type |*Billing Type
> Vendors ™ | |[Demestic Airfare | |[07012000 [ [ 42000 |usp  [Outof Pocketx] |[FIU Expense =]
> Purchasing
> Inventory " | [Demestic Auto Rental | |[o7ioi2000 [ || noo|usD =l |[FuEpense =]

[- Services Procurement |

> Sourcing

(> Engineering I
(- Manufacturing Definitions
[ Production Control

(- Configuration Modeler

[ Product Configurations

> Quality

> Demand Planning

=l

Delete Selected |

Copy Selected |

Authorized Amount:

New Expense =] Ada

420.00 USD

Check Far Errors

[+ Inventory Policy Planning |
[+ Supply Planning

Update Totals |

[- Grants

2ave for Later Submit

Create A Cash Advance

Project Summary Printable View

> Program it

(- Project Costing

> Proposal Management

[ Maintenance Management
(- Resource Management

b nmra Adminictratinn

Beturn to Travel Authorization

L @me

0% -

Step | Action

54.

Enter the desired information into the Amount field. Enter "500.".

Last changed on: 10/2/2009 8:07 AM
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FIU

Search:
&

- My Favorites
[ Student Administration
- Employee Self-Service

> Service Request

[> Procurement

[> Assets

[» Travel and Expenses

— Open Resource Reguesis

— Employee Project Center
— Travel and Expense Center

Create Travel Autherization

Mew Window | Help | Customize Page | 15

Travel Authorization Entry
Patty Panthar

=

User Defaults

*Description:

[Call. of Bus MBA Seminar

Authorization ID: NEXT

Comment:

Purpose:

> Manager Self-Service
[+ Supplier Contracts

[- Customers

[- Products

[ Promotions

[ Customer Contracts

(- Order Management

(> Pricing Configuration
[ Customer Returns

[- ltems

[+ Cost Accounting

[- Vendors

> Purchasing

[ Inventory

[- eProcurement

[- Services Procurement
> Sourcing

(> Engineering

(- Manufacturing Definitions
[ Production Control

(- Configuration Modeler
[ Product Configurations
> Quality

> Demand Planning

[+ Inventory Policy Planning
[+ Supply Planning

|Semmar

H

Default Location: |Ca\iforma Bakersfield

a

“Date From:

[07/01/2008 [ “Date To: [07/05/2009

Accounting Defaults

More Options:

“Expense Type Date “Amount Currency *Payment Type |*Billing Type
™ | |[Demestic Airfare | |[07012000 [ [ 42000 |usp  [Outof Pocketx] |[FIU Expense =]
™ | |[Demestic Auto Rental =1 |[07/0172000 [ [ 500, [usD | =l |[FuEpense =]

I E

I =l

Copy Selected | Delete Selected |

Authorized Amount:

New Expense =] Ada

420.00 USD

Check Far Errors

Update Totals |

> Proposal Management
[ Maintenance Management
(- Resource Management

b nmra Adminictratinn

I Grants Save for Later Submit
[+ Program it
(- Project Costing

Beturn to Travel Authorization

Create A Cash Advance

Project Summary

Printable View

I

|| @ mrernet

5, 100%

A

Step

Action

55.

Click the Out of Pocket list item.
L -1

Page 14
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FIU

Search:

(O]

- My Favorites

> Student Administration Create Travel Autherization

Home | workist |

Mew Window | Help | Customize Page | 15

- Employee Self-Service
> Service Request
[> Procurement
[> Assets
[» Travel and Expenses o

Travel Authorization Entry
Patty Panthar

User Defaults

Authorization ID: NEXT

— Open Resource Reguesis

e e [Call. of Bus MBA Seminar
Emplovee Froject Center

*Description:

Comment:

— Travel and Expense Center

|Semmar
> Manager Self-Service

Purpose:

H

(- Supplier Contracts Default Location: |Ca\iforma Bakersfield

a

[- Customers
[- Products
[ Promotions

*Date From: |I]7f|]112EIIJEI *Date To:

07/05/2009

[ Customer Contracts

- Order Management Accounting Defaults

More Options: |

(> Pricing Configuration
(> Customer Returns

[- eProcurement

[- ltems B B B B E
— |Select| “Expense Type “Billing Type
© Cast Accounting Select| |"Expense Type Date ‘Amount Currency *Payment Type |*Billing Type
> Vendors ™ | |[Demestic Airfare | |[0701:2000 [ [ 42000 |usp  [Outof Pocketx] |[FIU Expense =]
> Purchasing
> Inventory " | [Demestic Auto Rental | |[o7ioi2000 [ || 500, [UsD Out of Pockefid || FEIETEE RS

[- Services Procurement |

> Sourcing

(> Engineering I
(- Manufacturing Definitions
[ Production Control

(- Configuration Modeler

[ Product Configurations

> Quality

> Demand Planning

=l

Delete Selected |

Copy Selected |

Authorized Amount:

New Expense ~| Add Check For Efrors

420.00 USD

[+ Inventory Policy Planning |
[+ Supply Planning

Update Totals |

(> Grants

> Program it

(- Project Costing

> Proposal Management

[ Maintenance Management
(- Resource Management

b nmra Adminictratinn

2ave for Later Submit

Beturn to Travel Authorization

Create A Cash Advance Project Summary Printable View

| Sian out

N

100 -

/@ tnternet

A

Step | Action

56. | Click the Expense Type list.

| 5|

57. | Click the Payment Type list.

58.

Qut of Pocket

Last changed on: 10/2/2009 8:07 AM
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Business Process Document
PS FIN 9.0-FOUNDATION (FIU02): FIUO2-Creating a T.A. ‘m@ap
(TAR)

FIU

Search: = New Window | Help | Customize Page | 15

®

- My Favorites

[> Student Administration

|7 I L SR TR Travel Authorization Entry
> Service Request
[> Procurement Patty Panther User Defaults Authorization ID: NEXT
[> Assets
[» Travel and Expenses o
7Hmﬂ"u’:{:%“;§:§;ﬁ;‘5 “Description: |cm| of Bus MBA Seminar Comment: =
— Travel and Expense Center Purpose: Seminar - =

> Manager Self-Service P I J J

(- Supplier Contracts Default Location: |Ca\iforma Bakersfield Q

[> Customers

I Products *Date From: II]?/I]VZEII]EI *Date To: |07/05/2009

> Promotions

[ Customer Contracts

(- Order Management

(> Pricing Configuration

[ Customer Returns

Create Travel Autherization

Accounting Defaults IMore Options: =] so |

(- ltems P P P P P—

© Cast Accounting —! Expense Type Date ‘Amount Currency |*Payment Type |*Billing Type

> Vendors ™ | |[Demestic Airfare | |[07012000 [ [ 42000 |usp  [Outof Pocketx] |[FIU Expense =]
(> Purchasing

- Inventory ™ | |[Demestic Auto Rental ~||[ozorizo0aE ([ 50000 |UsD  |[outofPocket'x] |[FIU Expense =]
(> eProcurement

> Services Procurement " | |[Domestic Lodging | (0710112008 [5 0.00|USD ~||[FlUEspense |
> Sourcing

(> Engineering I ﬂ ‘

(- Manufacturing Definitions
[> Production Control Copy Selected | Delete Selected | New Expense ~| Add Check For Errors
(- Configuration Modeler
[ Product Configurations
> Quality

> Demand Planning

[+ Inventory Policy Planning | Update Totals |
[+ Supply Planning

[- Grants
© Program it Save for Later Submit Create A Cash Advance Project Summary Printable View
(- Project Costing

> Proposal Management

[ Maintenance Management
(- Resource Management j

b nmra Adminictratinn

Dore [T T [emtene e -

Authorized Amount: 920.00 USD

Beturn to Travel Authorization

Step | Action

59. Click the Domestic Meals list item.
[ I

Page 16 Last changed on: 10/2/2009 8:07 AM




!.{; TeuSed

Business Process Document

PS FIN 9.0-FOUNDATION (FIU02): FIUO2-Creating a

T.A. (TAR)

FIU

Search:

(O]

- My Favorites Create Travel Autherization

indow | Help | Customi Processing

[ Student Administration
- Employee Self-Service
> Service Request
[> Procurement
[> Assets
[» Travel and Expenses o

Travel Authorization Entry
Patty Panthar

User Defaults

Authorization ID: NEXT

— Open Resource Reguesis

— Employee Project Center “Description:

[Call. of Bus MBA Seminar

Comment:

— Travel and Expense Center

|Semmar
> Manager Self-Service

Purpose:

H

(- Supplier Contracts Default Location: |Ca\iforma Bakersfield

a

[- Customers
[- Products
[ Promotions

“Date From:

[07/01/2008 [ “Date To: [07/05/2009

[ Customer Contracts
(- Order Management

Accounting Defaults

More Options:

(> Pricing Configuration
(> Customer Returns

(- ltems . | P TP P———

© Cast Accounting —! Expense Type Date ‘Amount Currency |*Payment Type |*Billing Type

> Vendors ™ | |[Demestic Airfare | |[07012000 [ [ 42000 |usp  [Outof Pocketx] |[FIU Expense =]
(> Purchasing

- Inventory ™ | |[Demestic Auto Rental ~||[ozorizo0aE ([ 50000 |UsD  |[outofPocket'x] |[FIU Expense =]
(> eProcurement

[ Services Procurement " | |[Domestic Lodging | (0710112008 [5 0.00|USD [Out of Pocket ] |[FIU Expense x|
> Sourcing

> Engineering A

(- Manufacturing Definitions
[ Production Control

(- Configuration Modeler

[ Product Configurations

> Quality

> Demand Planning

Copy Selected | Delete Selected |

Authorized Amount:

MNew Expense ~| Add

920.00 USD

Check Far Errars

[+ Inventory Policy Planning |
[+ Supply Planning

Update Totals |

(> Grants

> Program it

(- Project Costing

> Proposal Management

[ Maintenance Management
(- Resource Management

ol amen A

Save for Later Submit

Beturn to Travel Authorization

minietratinn

Create A Cash Advance

Project Summary

Printable View

waiting For https:fipsstage. flu.edu:B600/pscipsFsstg/EMPLOYEE/ERP/c/ADMINISTER_EXPENSE_FUNCTIONS.T| |

g

/@ trternet

0% -

Step

Action

60.

Enter the desired information into the Amount field. Enter "500".

Last changed on: 10/2/2009 8:07 AM
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Business Process Document

PS FIN 9.0-FOUNDATION (FIU02): FIUO2-Creating a T.A.

(TAR)

W rentzseps

FIU

Search:
&
- My Favorites
[ Student Administration
- Employee Self-Service
> Service Request
[> Procurement
[> Assets
[» Travel and Expenses
— Open Resource Reguesis

— Employee Project Center
— Travel and Expense Center

Create Travel Autherization

Mew Window | Help | Customize Page | 15

Travel Authorization Entry

> Manager Self-Service

[+ Supplier Contracts

[- Customers

[- Products

[ Promotions

[ Customer Contracts

(- Order Management

(> Pricing Configuration

[ Customer Returns

[- ltems

[+ Cost Accounting

[- Vendors

> Purchasing

[ Inventory

[- eProcurement

[- Services Procurement

> Sourcing

(> Engineering

(- Manufacturing Definitions
[ Production Control

(- Configuration Modeler

[ Product Configurations
> Quality

> Demand Planning

[+ Inventory Policy Planning
[+ Supply Planning

[- Grants
> Program

it

Patty Panther User Defaults
=)
=Description: [Call. of Bus MBA Seminar
Purpose: |Semmar =l
Default Location: |Ca\iforma Bakersfield (s}

“Date From:

[0701/2008 [ “Date To: [07/05/2009

Authorization ID: NEXT

Comment:

Accounting Defaults

More Options:

Copy Selected | Delete Selected |

Authorized Amount:

*Expense Type *Date WT&HCV Payment Type Billing Type
™ | |[Demestic Airfare =||[o7orz009 B || 42000 |usD  |[outof Pocket'=] |[FIU Expense =] | Detail
™ | |[Demestic Auto Rental =] |[o701:2000 0 [ 50000 |usD  |[Outaf Pocket=] |[FIU Expense =]
" | |[Domestic Lodging | (0710112008 [5 0.00|USD [Out of Pocket ] |[FIU Expense ] |:Dstail
" | |[Domesticlieals =1 (070172009 5 [ s00|usp | =l|[FluEpense =] |:Detail

MNew Expense ~| Add

920.00 USD

Check Far Errars

Update Totals |

Save for Later Submit

(- Project Costing

> Proposal Management

[ Maintenance Management
(- Resource Management

b nmra Adminictratinn

Beturn to Travel Authorization

Create A Cash Advance

Project Summary Printable V

W

[T T € nternet ES

Step

Action

61.

Click the Out of Pocket list item.
L =
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Business Process Document

!.{; TeuSed

PS FIN 9.0-FOUNDATION (FIU02): FIUO2-Creating a

T.A. (TAR)

FIU

Search:

(O]

- My Favorites

> Student Administration Create Travel Autherization

Mew Window | Help | Customize Page | 15

- Employee Self-Service
> Service Request
[> Procurement
[> Assets
[» Travel and Expenses
— Open Resource Reguesis
— Employee Project Center
— Travel and Expense Center
> Manager Self-Service
[+ Supplier Contracts
[- Customers
[- Products
[ Promotions

Travel Authorization Entry
Patty Panther User Defaults

=

[Call. of Bus MBA Seminar

|Semmar

*Description:

[Califernia Bakersfield Q
[07/01/2008 [ “Date To: [07/05/2009

Purpose:

Default Location:

“Date From:

Authorization ID: NEXT

Comment:

[ Customer Contracts

- Order Management | Accounting Defaults

More Options:

(> Pricing Configuration
(> Customer Returns

(- Manufacturing Definitions
[ Production Control

(- Configuration Modeler

[ Product Configurations

> Quality

> Demand Planning

Copy Selected | Delete Selected

Authorized Amount: 9

[- ltems .  PPTpE Dr—
— “Expense Type g Typ

© Cast Accounting Expense Type Date ‘Amount Currency *Payment Type |*Billing Type

> Vendors ™ | |[Demestic Airfare | |[07012000 [ [ 42000 |usp  [Outof Pocketx] |[FIU Expense =]

> Purchasing

- Inventory ™ | |[Demestic Auto Rental ~||[ozorizo0aE ([ 50000 |UsD  |[outof Pocket'=] |[FIU Expense =]

[- eProcurement

[ Services Procurement " | |[Domestic Lodging | (071012008 [5 0.00|USD [Out of Pocket ] |[FIU Expense x|

> Sourcing

> Engineering " | |[Domesticlieals =1 (070172009 5 [ 500 |USD EESERRE - | |[FU Expense =]

MNew Expense ~| Add

Check Far Errars

20.00 USD

[+ Inventory Policy Planning
[+ Supply Planning

Update Totals |

[- Grants

- Program Save for Later

Submit

it

Create A Cash Advance

Project Summary Printable Vi

W

(- Project Costing

> Proposal Management

[ Maintenance Management
(- Resource Management

b nmra Adminictratinn

Beturn to Travel Authorization

=

Internet 100%
N ™ 5

A

Step | Action

62. | Select the FIU Expense

Last changed on: 10/2/2009 8:07 AM
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Business Process Document

PS FIN 9.0-FOUNDATION (FIU02): FIUO2-Creating a T.A.

(TAR)

W rentzseps

FIU

Search:
®
- My Favorites
[ Student Administration
- Employee Self-Service
> Service Request
[> Procurement
[> Assets
[» Travel and Expenses
— Open Resource Reguesis

— Employee Project Center
— Travel and Expense Center

Create Travel Autherization

e R | | sianout

Mew Window | Help | Customize Page | 15

Travel Authorization Entry

> Manager Self-Service
[+ Supplier Contracts

[- Customers

[- Products

[ Promotions

[ Customer Contracts

(- Order Management

(> Pricing Configuration
[ Customer Returns

[- ltems

[+ Cost Accounting

[- Vendors

> Purchasing

[ Inventory

[- eProcurement

[- Services Procurement
> Sourcing

(> Engineering

(- Manufacturing Definitions
[ Production Control

(- Configuration Modeler
[ Product Configurations
> Quality

> Demand Planning

[+ Inventory Policy Planning
[+ Supply Planning

[- Grants

> Program it

Patty Panther User Defaults Authorization 1D: NEXT
=)
=Description: [Call. of Bus MBA Seminar Comment: =]
Purpose: |Semmar =l =
Default Location: |Ca\iforma Bakersfield Q,

“Date From:

[07/01/2008 [ “Date To: [07/05/2009

Accounting Defaults

More Options: |

Copy Selected |

“Expense Type “Date “Amount Currency *Payment Type |*Billing Type

[Domestic Aifare =||[o7orz009 B || 42000 |usD  |[outof Pocket'=] |[FIU Expense =] | Detail
[Damestic Auto Rental ~||[ozorizo0aE ([ 50000 |UsD  |[outof Pocket'=] |[FIU Expense =]
[Domestic Lodging | (071012008 [5 0.00|USD [Out of Pocket ] |[FIU Expense ] |:Dstail
[Domestic Meals x| |[o7i01/2009 [5 || 500 |USD RS | |[FU Epense =] |zDetail

Delete Selected |

Authorized Amount:

MNew Expense ~| Add Check For Errors

920.00 USD

Update Totals |

Save for Later

Submit

(- Project Costing

> Proposal Management

[ Maintenance Management
(- Resource Management

b nmra Adminictratinn

Beturn to Travel Authorization

Create A Cash Advance Project Summary Printable View

[ [T € nternet BN

Step

Action

63.

Check

or Errars

Click the Check For Errors button.

If you have any missing information, you will see red flags in next to the
expense type.

64.

button.

(]

Click the Missing or invalid information was found. Click this icon to view

Page 20
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Business Process Document
PS FIN 9.0-FOUNDATION (FIU02): FIUO2-Creating a
T.A. (TAR)

FIU

Search:

(O]

- My Favorites
[ Student Administration
- Employee Self-Service
> Service Request
[> Procurement
[> Assets
[» Travel and Expenses
— Open Resource Reguesis
— Employee Project Center
— Travel and Expense Center
> Manager Self-Service
[+ Supplier Contracts
[- Customers
[- Products
[ Promotions
[ Customer Contracts
(- Order Management
(> Pricing Configuration
[ Customer Returns
[- ltems
[+ Cost Accounting
[- Vendors
> Purchasing
[+ Inventory
[- eProcurement
[- Services Procurement
> Sourcing
(> Engineering
(- Manufacturing Definitions
[ Production Control
(- Configuration Modeler
[ Product Configurations
> Quality
> Demand Planning
[+ Inventory Policy Planning
[+ Supply Planning
[- Grants
> Program Management
(- Project Costing
> Proposal Management
[ Maintenance Management
(- Resource Management

b nmra Adminictratinn

Home | workist | | _Signout
New Window | Help | Customize Page | i5h
Create Travel Authorization
Authorization Detail for Domestic Airfare (Line 1)
Patty Panther Authorization ID: NEXT

Please enter or update the following information:

P Merchant (Preferred or Non-Preferred)
About This Expense
“Date: b7/01/2009
*Payment Type: Out of Pocket -
*Billing Type: FIU Expense =
Ticket Number:
“Merchant (Choose One):
Preferred: lﬁ
ronsrteres:
*Amount: 42000 ysp

Location Amount: |

Accounting Detail
Check Expense For Errors

Eeturn to Travel Authorization Entry

Done

N

100 -

| tnternet

A

Step

Action

65.

Enter the desired information into the Non-preferred field. Enter "Delta".

Last changed on: 10/2/2009 8:07 AM
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Business Process Document

PS FIN 9.0-FOUNDATION (FIU02): FIUO2-Creating a T.A.

(TAR)

W rentzseps

FIU

Search: =

(O]

- My Favorites

. Student Administration Create Travel Authorization

Home | Workist | _AddioFavortes | Signout

Mew Window | Help | Customize Page | 15

- Employee Self-Service
> Service Request

[ Procurement Parthy Panther

[ Assets ) )
I Travel and Expenses Please enter or update the following information:
— Open Resource Requests P Merchant (Preferred or Non-Preferred)

— Emplovee Project Center
— Travel and Expense Center
> Manager Self-Service

[+ Supplier Contracts N =

[ Customers Date: o’ 009

- Products *Payment Type: Out of Pocket -

> Promotions N | FIU Eﬁ)ansa v

> Customer Contracts Billing Type: e @
(- Order Management Ticket Humber:

- Pricing Configuration “Merchant (Choose One):

[ Customer Returns Preferred: lﬁ
(> Items

[> Cost Accounting = Hon-preferred: _
> Vendors -

(> Purchasing *Amount: 42000 pgp

[+ Inventory

[- eProcurement

Authorization Detail for Domestic Airfare (Line 1)
Authorization ID:

About This Expense

NEXT

[> Services Procurement Location Amount: |

> Sourcing

(> Engineering Accounting Detail

(- Manufacturing Definitions

[ Production Control Check Expense For Errors

(- Configuration Modeler

[ Product Configurations Return to Travel Authorization Entry
> Quality

> Demand Planning

[+ Inventory Policy Planning
[+ Supply Planning

[- Grants

> Program Management

(- Project Costing

> Proposal Management

[ Maintenance Management
(- Resource Management j

b nmra Ardminictratinn

Done

T € ternet

H100% -

Step | Action

66.

|Return to Travel Autharization Entry |

Click the "Return to Travel Authorization Entry" to return to the TA page

Page 22
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Business Process Document
PS FIN 9.0-FOUNDATION (FIU02): FIUO2-Creating a

T.A. (TAR)

Search:

®
- My Favorites
[ Student Administration
- Employee Self-Service
> Service Request

FIU

Create Travel Authorization

| workist

Mew Window | Help | Customize Page | 15

| _Add to Favorites

| Sian out

Authorization Detail for Domestic Lodging (Line 3)

> Procurement Pathy Panther Authorization ID: NEXT
[ Assets )
> Travel and Expenses Please enter or update the following information:
— QOpen Resource Reguests = nightly Rate
— Emplovee Project Cents
o Trrgvel\]a?; Erxﬂ :HS:Q;[‘N " Accounting Detail - Monetary amount cannot be 0 on distribution line 1.
Iravel and Expense Lenter
> Manager Self-Service P‘ ‘Accounting Detail - Monetary amount cannot be 0 on distribution line 2.
[+ Supplier Contracts
[- Customers
[ Products About This Expense
[ Promotions = . W 5
[ Customer Contracts Date:
[> Order Management *Payment Type: Out of Pocket j'
(> Pricing Configuration *Billing Type: FIU Expense =
[ Customer Returns —
> ltems HNumber of Hights: 1
s “Nightly Rate: S -
endors . .
> Purchasing Total Amount: 0.00 USD
[+ Inventory
[- eProcurement
- Services Procurement Location Amount: [
> Sourcing
- Engineering
(- Manufacturing Definitions
- Production Control Check Expense For Errors
(- Configuration Modeler
[> Product Configurations Return to Travel Authorization Entry
> Quality
> Demand Planning
[+ Inventory Policy Planning
[+ Supply Planning
[- Grants
> Program Management
(- Project Costing
> Proposal Management
[ Maintenance Management
(- Resource Management
F 1 naen Ardminictration
Done T & mtermet e -

67.

Enter the desired information into the Number of Nights field. Enter "5".

68.

Enter the desired information into the Nightly Rate field. Enter "220.".

69.

Click the Check Ex

ense For Errors button.

| Check Expense For Errors

70.

Click the Return to Travel Authorization Entry link.

[Return to Travel Authorization Entry

Last changed on: 10/2/2009 8:07 AM
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Business Process Document

PS FIN 9.0-FOUNDATION (FIU02): FIUO2-Creating a T.A.

(TAR)

W rentzseps

FIU

Search:
(- My Favorites - .
> Student Administration Create Travel Autherization

e R | | sianout

Mew Window | Help | Customize Page | 15

- Employee Self-Service
> Service Request

[> Procurement

[> Assets

[» Travel and Expenses

Travel Authorization Entry
Patty Panthar

=

User Defaults

— Open Resource Reguesis

e e [Call. of Bus MBA Seminar
Emplovee Froject Center

*Description:

Comment:

— Travel and Expense Center

Purpose:
> Manager Self-Service

|Semmar

H

[+ Supplier Contracts
[- Customers

Default Location: |Ca\iforma Bakersfield

a

[ Products “Date From:

[ Promotions

[0701/2008 [ “Date To: [07/05/2009

Authorization 1D: NEXT

[ Customer Contracts

- Order Management Accounting Defaults

More Options: |

(> Pricing Configuration
(> Customer Returns

(- Manufacturing Definitions
[ Production Control

(- Configuration Modeler

[ Product Configurations

> Quality

> Demand Planning

Copy Selected | Delete Selected |

Authorized Amount:

[ Items » . N . .

— “Expense Type “Date g Typ
© Cast Accounting Expense Type Date ‘Amount Currency |*Payment Type | *Billing Type
> Vendors [Domestic Aifare =l|[o7ior2009 B [ 42000 |usD  |[outofPocket =] |[FIU Expense =] | Detail
> Purchasing
> Inventory [Damestic Auto Rental =l|[o7o1iz009 G [ s00.00 |usD  ([OutefPocketz] |[FIU Expense =] |Detail
[- eProcurement
[ Services Procurement [Domestic Lodging =] |[o7/01/2008 5 1,100.00 |USD [out of Pocket =] |[FIU Expense =] | Detail
> Sourcing
> Engineering [Domestic Meals =||[o7iori2009 B || 50000 |usD  |[Outof Pocket =] |[FIU Expense =] |:Detail

MNew Expense - Add

2,520.00

Check For Errors

usD

[+ Inventory Policy Planning
[+ Supply Planning

Update Totals |

(> Grants

> Program
(- Project Costing

> Proposal Management

[ Maintenance Management
(- Resource Management

b nmra Adminictratinn

Save for Later Submit

it

Beturn to Travel Authorization

Create A Cash Advance

Project Summary Printable View

Done

[T T € nternet ES

Step

Action

71.

Click the Check For Errors button.

Checl For Errars

72.

Click the Submit button.
| Submit I
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Business Process Document
PS FIN 9.0-FOUNDATION (FIU02): FIUO2-Creating a

T.A. (TAR)

FIU

Search: =

(O]

- My Favorites
[ Student Administration
- Employee Self-Service
> Service Request
[> Procurement
[> Assets
[» Travel and Expenses
— Open Resource Reguesis
— Employee Project Center
— Travel and Expense Center
> Manager Self-Service
[+ Supplier Contracts
[- Customers
[- Products
[ Promotions
[ Customer Contracts
(- Order Management
(> Pricing Configuration
[ Customer Returns
[- ltems
[+ Cost Accounting
[- Vendors
> Purchasing
[+ Inventory
[- eProcurement
[- Services Procurement
> Sourcing
(> Engineering
(- Manufacturing Definitions
[ Production Control
(- Configuration Modeler
[ Product Configurations
> Quality
> Demand Planning
[+ Inventory Policy Planning
[+ Supply Planning
[- Grants
> Program Management
(- Project Costing
> Proposal Management
[ Maintenance Management
(- Resource Management j

b nmra Adminictratinn

| Sianout

Home | Workist | AddtoFavories
New Window | Help | Customize Page | 15
Create Travel Authorization
Submit Confirmation
Patty Panther Authorization 1D: MNEXT
Total: 2,520.00 UsD

“ Click OK to submit, or click Cancel to return to the travel autherization without submitting

OK Cancel

Done

I

| trternet

0% -

Step

Action

73.

Click the OK button.

Last changed on: 10/2/2009 8:07 AM
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Business Process Document

PS FIN 9.0-FOUNDATION (FIU02): FIUO2-Creating a T.A.

(TAR)

W rentzseps

FIU

Search:
[- My Favorites . P
> Student Administration View Travel Authorization

e R | | sianout

New Window | Hslp | Customize Pace | 5 =]

- Employee Self-Service

Travel Authorization Details
> Service Request

[ Procurement Patty Panthar
[> Assets
[» Travel and Expenses o
— Open R Reguest;
SlE s s Description: Coll. of Bus MBA Seminar

— Employee Project Center
— Travel and Expense Center

Business Purpose:
> Manager Self-Service

Seminar

> Supplier Contracts Status: Submission in Process
[> Customers

& Products Default Location: Califarnia, Bakersfield
Pl “Date From: 07/0112009  Date To:
[ Customer Contracts

User Defaults

07i05/2009

Authorization 1D: 0000034980

Comment:

LastUpdated: 0817/2009 By: 1522181

(- Order Management
(> Pricing Configuration
(> Customer Returns

More Options: |

[+ Supply Planning
[- Grants

(> Items
[> Cost Accounting el
[- Vendors *Expense Type *Amount Currency *Payment Type
b Purchasing Domestic Aifare | 07/01/2009 420.00|USD Out of Packet FIUExpense  |‘Detall
[ Inventory
igetipempment Domestic Aulo 0710172009 500.00|USD out of Packet FIUExpense  |Detail
[ Services Procurement Rental
E souming DomesticLodging | 07/01/2009 1,100.00 |USD Out of Pocket FIU Expense “Detail
ineeri
I Mr;gnlﬂactﬁng Definitions Domestic Meals 07/01/2009 500.00|USD Out of Pocket FIU Expense *Detail
[ Production Control
(- Configuration Modeler 3
[ Product Configurations Authorized Amount: 2,520.00 USD
[ Quality Less Non-Approved:
> Demand Planning 0.00 usD
(> Inventory Policy Plannil
> | = Due Employee: 2,520.00 USD

> Program Management
(- Project Costing

> Proposal Management
[ Maintenance Management
(- Resource Management

b nmra Adminictratinn

= | & Retum to search | | [ oty |

Eroject Summar Printable View

Done

[T e ternet BN

Step

Action

74.

Click the Home link.
| Home|

75.

End of Procedure.

Congratulations. You have successfully completed a T.A. for your travel.
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